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Resumo 
O presente estudo objetivou identificar áreas de conflitos em Áreas de Proteção 

Permanente (APP) e Áreas de Uso Restrito (AUR) no Parque Estadual do Rio Preto (PERP) 

e sua Zona de Amortecimento (ZA). O trabalho parte das evidências de entender o estado 

de conservação no PERP e sua ZA aplicando as diretrizes de APP e AUR apresentados no 

Código Florestal Brasileiro vigente. Empregando recursos disponíveis em ambiente SIG 

(sistema de informações geográficas), delimitou-se e mapeou-se classes de uso da terra e 

as APP de nascentes e cursos d’água; bordas de tabuleiros ou chapadas; áreas com 

declividade superior a 45º; áreas com altitude superior a 1800 m; e AUR com base nos 

parâmetros, definições e limites estabelecidos pela Lei nº 12.651. A partir da sobreposição 

destes mapas analisou-se a ocorrência de conflito de uso na área. As classes de uso da 

terra foram: Afloramento Rochoso (49,70%), Formação Campestre (28,34%), Agropecuária 

(2,70%), Solo Exposto (4,62%) e Água (0,29%) Dentre as categorias de APP observamos 

maior ocorrência das APP nascentes (8,41%) e cursos d’água (54,24%). As APP 
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declividade > 45° (0,58%) e altitude superior a 1800 m (0,03%) apresentaram menor 

ocorrência. Os usos da terra em APP do tipo nascente e cursos d’água e AUR foram mais 

expressivos nas classes de Afloramento Rochoso, Formação Florestal e Formação 

Campestre. As classes de Agropecuária e Solo Exposto apresentaram baixa incidência no 

conflito de uso em todas as APP e AUR analisadas. Porém, ao analisar sua ocorrência 

entre as categorias de APP verificou-se maior ocorrência de uso indevido nas APP 

nascentes e cursos d’água. Com base nos resultados observamos a eficiência do uso das 

ferramentas nos SIG, confirmando a potencialidade deste como subsídio nas políticas 

públicas e gestão eficiente do uso da terra. 

 
Palavras–chave: Área de Uso Restrito, Código Florestal, Ordenamento Territorial, SIG, 

Unidades de Conservação. 

Abstract  
This study aimed to identify conflict areas in Permanent Protection Areas (APP) and 

Restricted Use Areas (AUR) in the Rio Preto State Park (PERP) and its Buffer Zone (ZA). 

The work starts from the evidence of understanding the conservation status in the PERP 

and its ZA applying the APP and AUR guidelines presented in the current Brazilian Forest 

Code. Using resources available in a GIS (geographic information system) environment, 

land use classes and APPs of springs and watercourses were delimited and mapped; board 

or plate edges; areas with a slope greater than 45º; areas with altitude above 1800 m; and 

AUR based on the parameters, definitions and limits established by Law No. 12,651. From 

the superposition of these maps, the occurrence of use conflicts in the area was analyzed. 

The land use classes were: Rocky Outcrop (49.70%), Campestre Formation (28.34%), 

Agriculture (2.70%), Exposed Soil (4.62%) and Water (0.29%). Among the APP categories, 

we observed a higher nascent APP (8.41%) and watercourses (54.24%). The APP slope > 

45° (0.58%) and altitude above 1800 m (0.03%) had less occurrence. The land uses in 

spring-type APP, watercourses, and AUR were more expressive in the Rocky Outcrop, 

Forest Formation, and Campestre Formation classes. The Agricultural and Exposed Soil 

classes showed a low incidence of conflict of use in all analyzed APP and AUR. However, 

when analyzing its occurrence among the APP categories, there was a higher occurrence 

of misuse in springs and watercourses APP. Based on the results, we observed the 

efficiency of the use of tools in GIS, confirming its potential as a subsidy in public policies 

and efficient management of land use. 

Keywords: Restricted Use Area, Forest Code, Spatial Planning, GIS, Conservation Units. 

 

1. INTRODUÇÃO 
 

A conservação ambiental, um dos grandes desafios da humanidade, consiste na 

concentração de esforços e recursos para a conservação e recuperação de áreas naturais 

consideradas estratégicas, das quais vários ecossistemas são dependentes. A 

conservação da biodiversidade é melhor sucedida minimizando as ações humanas em 
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paisagens intactas e não fragmentadas (BARLOW et al., 2016; BETTS et al., 2017), como 

áreas protegidas por Unidades de Conservação (MORANDI et al., 2020).  

No Brasil, a criação do Sistema Nacional de Unidades de Conservação (SNUC), pela 

Lei Federal n° 9.985/2000, dividiu em duas categorias as Unidades de Conservação (UC) 

em Proteção Integral e Uso Sustentável (BRASIL, 2000). A conservação das UC de 

Proteção Integral relaciona-se diretamente às atividades existentes em seu entorno 

definidas como Zona de Amortecimento (ZA), onde as atividades antrópicas estariam 

restritas e sujeitas a normas específicas para minimizar os impactos negativos sobre as UC 

(BRASIL, 2000). Já a Resolução CONAMA n° 428 de 2010 (BRASIL, 2010) trata do 

licenciamento de empreendimentos que possam afetar a UC ou sua ZA, com o objetivo de 

não permitir o uso e ocupação do solo de forma indevida. 

Tendo em vista que UC são áreas protegidas, a Lei nº 12.651, de 25 de maio de 

2012, conhecida como “Novo Código Florestal”, auxilia na gestão do uso da terra de seu 

entorno. Esta lei consiste em instrumento que estabelece as normas gerais sobre a 

proteção da vegetação, Áreas de Preservação Permanente (APP), áreas de Reserva Legal 

(ARL) e Áreas de Uso Restrito (AUR). APP possuem a função de preservar recursos 

hídricos, paisagem, estabilidade geológica e biodiversidade, facilitando o fluxo gênico de 

fauna e flora, protegendo o solo e assegurando o bem-estar das populações humanas 

(FEISTAUER et al., 2017). Já as AUR permitem o manejo florestal sustentável e o exercício 

de atividades agrossilvipastoris, bem como, a manutenção da infraestrutura física 

associada ao desenvolvimento das atividades, observando boas práticas agronômicas, 

sendo vedada a conversão de novas áreas, excetuadas as hipóteses de utilidade pública e 

interesse social (BRASIL, 2012; SOARES-FILHO et al., 2014; FRANÇA et al., 2018b; 

FRANÇA et al., 2020). 

O emprego das geotecnologias, como as técnicas de Sensoriamento Remoto (SR) 

e de Geoprocessamento, apresentam vantagens como ferramentas para mapeamentos, e 

no monitoramento da dinâmica do uso e ocupação do território, com maior frequência na 

atualização de dados, expressiva redução dos custos e de tempo na elaboração dos mapas 

(VAEZA et al., 2010; EUGENIO et al., 2017). Para a espacialização das APP o uso dos 

Sistemas de Informação Geográfica (SIG) é importante instrumento para o planejamento 

ambiental, onde podem ser identificadas as áreas que apresentam conflitos entre uso da 

terra e a legislação, o que facilita a gestão do território, a fiscalização e o cumprimento da 

lei (COUTINHO et al., 2013).  
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O Parque Estadual do Rio Preto (PERP) é uma UC de Proteção integral no Estado 

de Minas Gerais, criado em 1º de junho de 1994 (MINAS GERAIS, 1994), o qual trouxe 

benefícios socioambientais, como melhoria na qualidade da água, atividades turísticas e  

aproveitamento sustentável dos recursos hídricos, assegurando a proteção de nascentes 

da bacia hidrográfica do rio Jequitinhonha, sub-bacia do Araçuaí e do rio Preto. A região 

apresenta a predominância do Cerrado, bioma de extrema importância, pois é estimado 

que no Brasil apenas 0,85% deste esteja protegido integralmente (BRASIL, 2015), e 

atualmente sofre alta antropização dentre os grandes domínios vegetacionais do Brasil 

(BEUCHLE et al., 2015). 

O PERP objetivou em sua criação a preservação do rio Preto, afluente da margem 

direita do rio Jequitinhonha. Localiza-se no Mosaico Espinhaço: Alto Jequitinhonha – Serra 

do Cabral, na porção central da Reserva da Biosfera da Serra do Espinhaço (RBSE), 

reconhecida em 2005 pela UNESCO (UNESCO, 2005). A RBSE é a sétima reserva da 

biosfera do país, e possui importância como grande divisor de águas entre bacias 

hidrográficas federais, por possuir espécies de fauna e flora endêmicas, expressiva 

biodiversidade, e por ser uma das maiores formações de Campos Rupestres do Brasil 

(ECHTERNACHT et al., 2011; FREITAS et al., 2012; MARQUES; NAKAJIMA, 2015; MEIRA 

JUNIOR et al., 2017). 

O recorte deste trabalho é o PERP e sua ZA, e baseou-se em mapeamentos de uso 

e ocupação da terra, metodologias de delimitação de áreas de preservação permanente e 

áreas de uso restrito, conforme legislação vigente. Neste estudo, partimos do pressuposto 

de que os SIG podem gerar resultados em análise espacial da paisagem aplicáveis em 

tomadas de decisões ambientais e territoriais, e que alterações causadas nesta UC e sua 

ZA, que representam uma parte do sistema hidrológico da região, causarão desequilíbrios 

na dinâmica hídrica. Neste sentido, conhecer o estado de conservação de APP e AUR 

auxiliam em tomadas de decisão visando manutenção da qualidade dos mananciais 

presentes e promoção do fluxo gênico de fauna e flora na região.  

Diante do exposto, a presente pesquisa objetivou identificar, por meio do uso do SIG, 

áreas de conflitos em APP e AUR segundo o Código Florestal vigente, visando entender o 

estado de conservação no Parque Estadual do Rio Preto e sua Zona de Amortecimento. 
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2. CARACTERIZAÇÃO DA ÁREA DE ESTUDO  

A área de estudo abrange o Parque Estadual do Rio Preto (PERP) e sua ZA, com 

área total de aproximadamente 41.408,83 ha, Minas Gerais, Brasil, com centro de 

coordenadas em: 18°07’05” Sul e 43°20’43” Oeste (Figura 1). Localiza-se na porção central 

da Reserva da Biosfera Serra do Espinhaço (RBSE) (Figura 1) caracterizada por expressiva 

diversidade biológica e endemismo, rica diversidade sociocultural e por agregar áreas 

identificadas como insubstituíveis (MMA, 2019).  

O parque situa-se no município de São Gonçalo do Rio Preto e sua Zona de 

Amortecimento abrange parte desse município além de áreas de Felício dos Santos e Couto 

de Magalhães de Minas. O PERP e a ZA apresentam altimetrias variadas, sendo sua 

porção sul caracterizada por cotas altimétricas mais elevadas (entre 1815 e 1249 m) 

gradando para cotas menos elevadas em direção norte (1249 a 712 m) (Figura 1). 

Regionalmente, o clima predominante é mesotérmico (Cwb), tropical de altitude 

quente, com microclimas diversos relacionados a fatores topográficos, temperatura média 

anual de 18 a 19 °C, e precipitação anual de 850 a 1500 mm (ALVARES et al., 2013). Na 

região há afloramentos rochosos, Neossolos Litólicos, Quartzarênicos e Flúvico, 

Cambissolos e Latossolos (STCP, 2004a, b). 

As principais fitofisionomias presentes são típicas do bioma Cerrado, com formações 

campestres (Campo Limpo e Campo Rupestre); formações savânicas representadas pelo 

Cerrado típico e Cerrado Ralo e por áreas com Cerrado Rupestre. Nas proximidades de 

córregos e rios (Florestas Ciliares) são encontradas áreas com Floresta Estacional 

Semidecidual em associação com formações savânicas. Outras áreas de floresta ocorrem 

em mosaico com a vegetação campestre, formando os “capões de mata”, ou “Ilhas de 

Vegetação”, observados na face Sul do PERP (STCP, 2004a, b). 
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Figura 1 – Localização geográfica do Parque Estadual do Rio Preto e Zona de Amortecimento, PERP-ZA, 
Minas Gerais, Brasil. 
Fonte: os autores 

 

 
3. MATERIAL E MÉTODOS 

3.1. Base de dados e mapeamento do uso e ocupação da terra 

 
O mapa de uso e ocupação da terra foi confeccionado a partir de imagens compostas 

pelas cenas 23 kpa e 23 kpv do satélite Sentinel 2, de setembro de 2019, com resolução 

espacial de 10 x 10 m, do Serviço Geológico dos Estados Unidos (USGS, 2019). O recorte 

da área de estudo foi efetuado após a composição R4 (vermelho), G3 (verde), B2 (azul) em 

ambiente do ArcGis 10.5.1 (ESRI, 2016). Em seguida, mosaicou-se as imagens e extraiu a 

área de estudo, a partir de arquivo Shapefile do PERP e ZA. 
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A classificação supervisionada multiespectral realizada foi a Máxima 

Verossimilhança (MAXVER). A imagem raster após classificação executou a filtragem para 

remoção de pixels isolados, e posterior conversão em arquivo Shapefile. Para os fins de 

acurácia da classificação, elaboramos uma matriz de erro/confusão, que é considerada a 

forma mais efetiva em uma classificação temática (STEHMAN, CZAPLEWSKI, 1998). 

Utilizou-se o coeficiente de exatidão global (STEHMAN, 1996) e o coeficiente Kappa 

(BISHOP; FIENBERG; HOLLAND, 1975) segundo as equações 1 e 2 respectivamente: 

 

𝐺 =  
∑ 𝑛𝑖𝑗

𝑀
𝑗=1

𝑁
 

(Eq.1) 

Em que:  

G = Exatidão Global;  

M = número de classes presentes na matriz de erro;  

nij = número de elementos da diagonal da matriz de confusão;  

N = número total de unidades amostrais contempladas pela matriz. 

 

𝐾 =
𝑁 ∑ 𝑋𝑖𝑖 − ∑ 𝑋𝑖+𝑋+𝑖

𝑁² − ∑ 𝑋𝑖+𝑋+𝑖
 

(Eq.2) 

 

Em que: 

K = Índice Kappa de concordância; 

N = número de observações (verdades de campo);  

Xii = observações na linha i e coluna i (diagonal principal);  

Xi+ = total marginal da linha i; 

X+i = total marginal da coluna i. 

 

3.1. Base de dados e delimitação de APP e AUR  

 
Para a confecção dos mapas de delimitação de APP e AUR utilizou-se cenas de 

imagens do Modelo Digital de Elevação (MDE), provenientes do satélite ALOS (Advanced 

Land Observing Satellite) e sensor PALSAR (Phased Array L-band Synthetic Aperture 

Radar), com resolução espacial de 12,5 x 12,5 m, adquiridas gratuitamente no geoportal 

Alaska Satellite Facility/NASA (ASF, 2019).  

A partir do MDE, realizamos o mapeamento das APP dos tipos: (i) nascentes e 

cursos d’água; (ii) bordas de tabuleiros ou chapadas; (iii) áreas com declividade superior a 
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45º; (iv) áreas com altitude superior a 1800 m; e (v) AUR, áreas com declividade entre 25 e 

45º com base nos parâmetros, definições e limites estabelecidos pela Lei nº 12.651 

(BRASIL, 2012). A hierarquização fluvial foi necessária para melhor definição e 

ordenamento das APP de nascente e cursos d’água e seguiu a metodologia de Strahler 

(1952). 

Geramos as informações de direção de fluxo, por meio do Arc Tool Box (Spatial 

Analyst Tools > Hydrology > Flow Direction), e o fluxo acumulado (flow accumulation), ou 

delimitação dos locais de drenagem dos cursos d’água (Spatial Analyst Tools > Hydrology 

> Flow Accumulation). Com base na direção de fluxo, delimitamos a hierarquia fluvial da 

drenagem (Spatial Analyst Tools > Hydrology > Stream Order). Com base na hidrografia 

fluvial geramos pontos a partir de vértices (Spatial Analyst Tools > Hydrology > Stream to 

Feature) para delimitação dos pontos representativos das nascentes.  

Para o plano de informações de APP nascentes, executamos o comando Buffer com 

delimitação de raio de 50 m no seu entorno (BRASIL, 2012). As APP cursos d’água, nos 

rios de 4ª e 5ª ordem (com espelhos d’agua visíveis na imagem de alta resolução), 

mensuramos largura em 60 pontos aleatórios ao longo da hidrografia presente na área de 

estudo, por meio da ferramenta Mensuration, para posterior cálculo da média das larguras 

desses cursos d’água. As larguras médias calculadas foram de 8,5 m para os rios com 

largura de até 10 m e de 17,5 m para os de 10 a 50 m. Com uso da ferramenta Buffer, 

delimitamos as zonas tampões de 30 m (cursos d’água com largura de até 10 m) e de 50 

m (cursos d’água com largura entre 10 e 50 m), conforme BRASIL (2012). 

A identificação de APP de borda de tabuleiros ou chapadas foi realizada a partir da 

análise do MDE por meio da inserção de vetor (linha) sobre essas feições, seguido do 

comando Buffer unilateral de 100 m para a delimitação. As APP com declividade superior 

a 45º foram obtidas com uso do comando Slope (Spatial Analyst Tools > Surface > Slope), 

gerando um raster de declividade a partir do MDE. Pelo comando Classify do Layer 

Symbology gerou-se classes de áreas com inclinação inferiores e superiores a 45º. Para 

reclassificação do novo raster utilizou-se o comando Reclassify, e converteu-se para 

Shapefile (Conversion Tools > From Raster > Raster to Polygon). Em seguida, eliminamos 

as feições com declividade inferior a 45º, e calculamos as áreas dos polígonos 

representativos das APP com declividade superior a 45º segundo metodologia de França 

et al. (2020). Para APP com altitude superior a 1800 m utilizamos o comando Classify do 

layer Symbology, tendo o MDE como raster de entrada, gerando classes de áreas com 

altitude inferiores e superiores a 1800 m. Pelo comando reclassify obteve-se a 
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reclassificação do novo raster e converteu-se para shapefile. As feições com altitude 

inferiores a 1800 m foram eliminadas, e calculou-se as áreas dos polígonos representativos 

das APP com altitude superior a 1800 m. 

O procedimento para cálculo das AUR, sítios com declividades entre 25 e 45º seguiu 

procedimentos de França et al. (2018a; 2020). Realizado a partir do raster de declividade, 

executamos a segregação dos declives para verificar a existência ou não de AUR. Após 

identificação, executamos nova segregação para classificá-las, a partir do comando 

Classified, dividindo-as em duas (2) classes, por meio do ajuste do 1º Break Value para 25 

e o 2º Break Value para 45, classificando áreas abaixo de 25º; e áreas acima de 25º e até 

45º. Realizou-se, então, a reclassificação para o novo raster, pelo comando Reclassify e a 

conversão para shapefile, a partir do comando Raster to Polygon e calculou-se as áreas 

dos polígonos representativos das AUR. 

Para a confecção do mapa de APP totais e AUR agrupamos os dados obtidos em 

um arquivo Shapefile, sem sobreposições, com a seguinte ordem: APP nascentes, APP 

cursos d’água, APP bordas de tabuleiros ou chapadas, APP com declividade superior a 

45º, APP com altitude superior a 1800 m e AUR. 

 
3.2. Análises dos Dados 

 
A partir dos mapas de uso e ocupação da terra e das classes de APP e AUR, 

realizamos a operação de sobreposição de mapas utilizando a ferramenta Clip com objetivo 

de identificar as áreas conflitantes com o Código Florestal. Foram consideradas de uso 

adequado do solo todas as áreas com afloramento rochoso, floresta (exceto, floresta 

plantada), campo e água. As áreas ocupadas por floresta de eucalipto, solo exposto e 

agropecuária foram consideradas de uso inadequado do solo, ou seja, em desacordo a 

legislação vigente. 

Para validação do mapeamento do uso e cobertura da terra, realizamos diagnósticos 

de campo nos meses de novembro de 2019 e janeiro de 2020, totalizando 5 dias.  Na Figura 

2 está apresentado o fluxograma das etapas realizadas para a obtenção dos resultados, 

subdividido no escopo metodológico geral e no detalhamento de etapas realizadas para 

análise de conflitos em APP e AUR no Parque Estadual do Rio Preto e Zona de 

Amortecimento. 
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Figura 2 - Etapas realizadas para análise de conflitos em APP e AUR no Parque Estadual do Rio Preto e 
Zona de Amortecimento, estado de Minas Gerais, Brasil. 
Fonte: Os autores. 
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4. RESULTADOS E DISCUSSÃO 

4.1. Classes de Uso da Terra 

 
O mapa de uso e ocupação da terra no PERP e ZA a partir da classificação 

supervisionada apresentou seis classes de uso da terra: (i) Agropecuária, (ii) Formação 

Florestal, (iii) Formação Campestre, (iv) Água, (v) Afloramento Rochoso e (vi) Solo Exposto 

(Figura 3) quantificadas na Tabela 1.  

 

 
Figura 3 - Classes de uso e ocupação da terra no Parque Estadual do Rio Preto e Zona de Amortecimento, 
Minas Gerais, Brasil, setembro/2019. 
Fonte: Os autores. 
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Tabela 1 - Quantificação das classes de uso e ocupação da terra no Parque Estadual do Rio Preto e Zona de 
Amortecimento, no Estado de Minas Gerais. 
 

Classes de uso e ocupação da terra 
Área 

(ha) (%) 

Afloramento Rochoso 20.578,81 49,70 

Formação Florestal 5.944,37 14,36 

Formação Campestre 11.737,02 28,34 

Solo Exposto 1.912,62 4,62 

Agropecuária 1.115,99 2,70 

Água 120,02 0,29 

Total (∑) 41.408,83 100,00 

Fonte: Os autores. 

 
 

O resultado da classificação realizada neste trabalho corrobora com os obtidos pelo 

Projeto de Mapeamento Anual da Cobertura e Uso do Solo do Brasil (MAPBIOMAS, 2018), 

onde observamos correspondência com mesmas classes obtidas neste estudo.  

A expressiva ocorrência das classes Afloramento Rochoso, Formação Campestre e 

Formação Florestal), totalizaram 92,40% da área de estudo. Classes de antropização 

observadas em menor proporção foram Solo Exposto e Agropecuária, que corresponderam 

a áreas de 1.912,62 ha (4,62%) e 1.115,99 ha (2,70%), respectivamente. A ocorrência da 

classe Água correspondeu a 0,29% (120,02 ha) da área total de estudo, formada por 

nascentes, córregos, riachos, sendo que os que se encontram dentro da área do PERP são 

tributários para o Rio Preto.  

A classe predominante na área foi Afloramento Rochoso, com 20.578,81 ha, 49,70% 

da área total. Isto corrobora com a formação geológica predominante na região que 

apresenta uma grande extensão de afloramentos rochosos vinculados às rochas 

quartzíticas do Supergrupo Espinhaço e quartzitos sericíticos do Grupo Macaúbas (SCTP, 

2004b; Morais et al. 2019). Formação Campestre apresentou área de 11.737,02 ha 

(28,34%), caracterizada pela predominância de espécies herbáceas, com raros arbustos e 

ausência completa de árvores em áreas de solos rasos, como exemplo, Neossolos Litólicos, 

Quartzarênicos e Flúvicos (SCTP, 2004b). A classe Formação Florestal correspondeu a 

14,36%, totalizando uma área de 5.944,37 ha. Destas, cerca de 194,08 ha (3,26%) 

compreendem florestas plantadas de Eucalyptus sp. no extremo Nordeste da Zona de 

Amortecimento do Parque. O restante vincula-se às Florestas Estacionais Semideciduais, 

condicionadas aos cursos d’água, distribuídas em manchas e de forma fragmentada.  

Apesar de pouco significativa a presença de plantios de Eucalyptus sp. em relação 

a área total, é importante destacar que a expansão deste tipo de atividade pode acarretar 

riscos a vegetação natural, bem como potencializar os conflitos de uso da terra. Dados de 
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uso e conflito da terra entre 1984 e 2013 em áreas protegidas na porção Sul do Mosaico do 

Espinhaço indicam expansão dessas florestas plantadas em cerca de 30.000 ha, o que 

pode ocasionar o aumento dos conflitos de uso de terras e a perda de conectividade na 

paisagem (RIBAS et al. 2016). 

Diante disso, é observada a necessidade da promoção de ações na ZA do PERP 

buscando outras formas para obtenção de renda com o uso de espécies florestais, como 

por exemplo a implantação de sistemas agroflorestais (SAF’s), empregando espécies 

nativas que apresentam potencial econômico sem gerar problemas, como a redução da 

conectividade entre fragmentos, que resultariam na perda do potencial gênico e ainda, de 

possíveis corredores ecológicos utilizados pela fauna local. Pois, os SAF’s objetivam aliar 

melhorias na produção agrícola com qualidade ambiental, como aumento da produtividade 

agrícola, maior eficiência no uso de insumos e na ciclagem de nutrientes, melhoraria na 

fertilidade do solo, controle de erosão, conservação da biodiversidade e diversificação da 

renda de famílias e comunidades (LEMAIRE et al., 2014; COULIBALY et al., 2017). Além 

disso, destaca-se a relação direta de SAF’s com ações públicas voltadas para o 

desenvolvimento rural, redução da pobreza rural e conservação ambiental (GONÇALVES; 

VIVAN, 2012), sendo estes sistemas praticados especialmente por pequenos agricultores 

(LORENZ; LAL, 2014). 

Apesar da baixa ocorrência de Solo Exposto e Agropecuária, salientamos a 

potencialidade de degradação ambiental em decorrência de processos erosivos resultantes 

do manejo inadequado de pastagens, pastejo intensivo e/ou uso de práticas agrícolas de 

maneira incorreta em áreas de lavoura, podendo ainda resultar na compactação do solo, e 

perda de nutrientes, ocasionando o abandono da área e consequentemente o aumento de 

áreas com solo exposto. A grande preocupação referente a processos erosivos é justificada 

pela variação dos índices de Erosividade no PERP apresentados por Soares et al. (2020), 

que variaram de 1,8 a 2.132,3 Mj.ha-1mmh-1. Os mesmos autores comentaram que a 

declividade do terreno, por sua vez, é uma variável importante para determinar o potencial 

erosivo de uma área, uma vez que quanto maior a inclinação de um terreno, maior será a 

velocidade de escoamento da água. Com base, nesta informação nota-se a importância da 

aplicação de práticas conservacionistas de solo e água por parte dos agricultores no 

entorno do parque visando a redução do referido problema. 

Para validação dos dados apresentados anteriormente construímos a matriz de 

confusão (Tabela 2), cuja identificação de 54 dos 62 pontos corresponderam com as 

informações obtidas pela classificação supervisionada e os pontos de validação obtidos 
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pela verdade de campo. O coeficiente Kappa foi de 0,80, valor considerado muito boa 

segundo Landis; Koch (1977). O coeficiente de exatidão global apresentou valor de 87,1%, 

ou seja, superior ao aceitável estabelecido por Congalton; Green (2008) que é de 85%. 

A busca por mais de um caminho de validação dos dados foi realizada visto que o 

cálculo do coeficiente Kappa para aplicações típicas de sensoriamento remoto tem sido 

questionada, uma vez que pode não refletir a concordância de uma classificação, apenas 

descontada a casualidade (FOODY, 2020). 

 

Tabela 2 - Matriz de confusão para a classificação supervisionada da imagem Sentinel - 2 para área de 
estudo. 
 

Classes 
Verdade de campo Total 

AR FF FC SE AP AG  

AR 31 0 0 0 0 0 31 

FF 1 4 1 0 1 1 8 

FC 2 0 11 1 0 1 15 

SE 0 0 0 4 0 0 4 

AP 0 0 0 0 2 0 2 

AG 0 0 0 0 0 2 2 

Total 34 4 12 5 3 4 62 

Kappa = 0,80        

Exatidão Global = 87,1% 

Legenda: AR - Afloramento Rochoso; FF - Formação Florestal; FC - Formação Campestre; SE - Solo Exposto; 
AP – Agropecuária; AG – Água 
Fonte: Os autores. 

 

4.2. Áreas de Preservação Permanente e Áreas de Uso Restrito 

 
De 41.408,83 há da área total do PERP e ZA, as APP do tipo nascente, cursos d’água 

com faixas marginais de 30 e 50 m, bordas de tabuleiros ou chapadas, áreas com 

declividade superior a 45º, áreas com altitude superior a 1800 m e AUR totais ocupam 

7.319,31 ha, equivalente a 17,68% da área de estudo (Figura 4, Tabela 3). As categorias 

que apresentaram menor e maior ocupação foram APP altitude (áreas com altitude superior 

a 1800 m) e APP de cursos d’água correspondendo a 0,0045% (1,85 ha) e 9,59% (3.970,32 

ha) da área de estudo, respectivamente. 
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Figura 4 - Categorias de APP e AUR mapeadas no Parque Estadual do Rio Preto e Zona de 
Amortecimento, no Estado de Minas Gerais. 
Fonte: Os autores. 
 
 

Tabela 3 - Quantificação de APP e AUR no Parque Estadual do Rio Preto e Zona de Amortecimento, no 
Estado de Minas Gerais 
 

Categorias Descrição 
Área 
(ha) 

% relativa à 
área de 
estudo 

% relativa à 
área total 

das 
categorias 

APP nascentes Raio de 50 m 615,89 1,49 8,41 

APP cursos d’água Largura de 30 e 50 m 3.970,32 9,59 54,24 

APP borda de tabuleiros Buffer de 100 m 127,64 0,31 1,74 

APP declividade > 45° Acima de 45º 42,62 0,10 0,58 

APP Altitude Acima de 1800 m 1,85 0,0045 0,03 

AUR Declividade 25-45º 2.560,99 6,18 35,00 

Total das categorias 7.319,31 17,68 100,00 

Total da área de estudo 41.408,83   

Fonte: Os autores. 
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Apesar da menor ocorrência da APP de áreas com altitude superior a 1800 m e de 

sua menor representatividade dentro das categorias de áreas de preservação que foi de 

0,03%, estas devem ser preservadas pela sua importância, devido à alta biodiversidade e 

endemismo dos campos rupestres influenciada, dentre outros, pela variação de altitude que 

ocorrem nestes ambientes (FERNANDES, 2016). 

Com relação às APP de cursos d’água que apresentaram maior ocupação na área 

total e maior representativa dentro das categorias (54,54%), as mesmas devem ser 

conservadas, visto que estas exercem expressiva influência na qualidade da água doce, e 

aumentam a proteção de todo ecossistema de atividades antrópicas que ocorrem nas 

bacias hidrográficas (VALLE JUNIOR et al., 2015; ANGELSTAM; LAZDINIS, 2017; LI et al., 

2018). As florestas presentes em APP de cursos d’água garantem ainda a manutenção da 

biodiversidade do solo, fornecem habitat para espécies aquáticas, promovem controle de 

inundação e estabilidade dos canais de drenagem, além de contribuírem com a recarga de 

aquíferos e na filtragem de sedimentos (POIANE et al., 2000; DWIRE; LOWRENCE, 2006; 

ANDERSON et al., 2014; NELSON et al., 2018). 

A categoria APP nascentes correspondeu a aproximadamente 615,89 ha (1,49%) do 

total da área analisada. Foram contabilizados no presente estudo 834 pontos de nascentes, 

sendo estes de suma importância para os recursos hídricos conforme mencionado por 

Donadio; Galbiatti; Paula (2005), no qual salientaram que uma vez sem proteção adequada 

no entorno das nascentes nota-se um processo de degradação do rio, havendo a 

necessidade de restauração da vegetação em mata ciliar como auxílio na proteção de 

recursos hídricos. 

As APP de áreas com declividade superior a 45º e de bordas de tabuleiros ou 

chapadas (buffer de 100 m) ocupam cerca de 42,62 ha (0,10%) e 127,64 ha (0,31%) da 

área de estudo, e correspondem a 0,58 e 1,74% das áreas de preservação, 

respectivamente. Em relação à APP de encosta, França et al. (2018b) apontaram a alta 

vulnerabilidade a processos erosivos e desmoronamentos destas áreas, em especial 

quando desprovidas de cobertura vegetal natural para região adjacente no território da 

Reserva da Biosfera da Serra do Espinhaço. Tal fato denota a importância de manutenção 

de cobertura nestas áreas e até mesmo de implantação de ações que visem a sua 

preservação. 

As AUR ocupam 2.560,99 ha (6,18%) da área total de estudo, a segunda em 

extensão areal dentre as categorias, equivalente a 35%. Porém, esta difere das APP pois 

segundo o Código Florestal (BRASIL, 2012), estas áreas serão permitidos o manejo 
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florestal sustentável e o exercício de atividades agrossilvipastoris, bem como a manutenção 

da infraestrutura física associada ao desenvolvimento das atividades, observadas boas 

práticas agronômicas, sendo vedada a conversão de novas áreas, excetuadas as hipóteses 

de utilidade pública e interesse social. 

 
4.3. Conflito de Uso da Terra 

 
Para identificação do conflito de uso da terra considerou-se como áreas de uso 

indevido as classes vinculadas às atividades antrópicas, como Agropecuária e Solo 

Exposto. As demais classes foram definidas de uso devido considerando a legislação 

vigente.  A Figura 5 ilustra o uso da terra, APP e AUR por meio do cruzamento dos mapas, 

como produto do conflito para a área de estudo. 

As classes vinculadas a sistemas naturais, Afloramento Rochoso, Formação 

Campestre e Formação Florestal apresentaram maior ocorrência dentro das APP, 

ocupando áreas de 2.129,48 (44,75%) e 1.264,54 ha (26,58%), respectivamente, o que em 

termos porcentuais representou 71,33% de todas as classes (Tabela 4). Solo Exposto e 

Agropecuária ocuparam 3,78% (179,83 ha) e 2,41% (114,87 ha) respectivamente, 

totalizando 6,19% e uma área total de 294,70 ha. 

Nas áreas de APP nascentes cerca de 21,31 ha apresentam a condição de solo 

exposto e 17,24 ha são utilizados para a agricultura ou pecuária. Já, em áreas de cursos 

d’água 158,34 ha apresentam solo exposto e 91,94 ha são utilizados pela agropecuária. 

Estes conflitos no uso da terra promovem redução da matéria orgânica do solo e na 

capacidade do solo de formar agregados estáveis (VALERA et al., 2016). Assim, 

desenvolve-se impactos ambientais como perda de solo, diminuição na qualidade da água 

e da biodiversidade (VALLE JUNIOR et al., 2014; VALLE JUNIOR et al., 2015; PACHECO 

et al., 2016). 
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Figura 5 - Uso e cobertura da terra em APP e AUR no Parque Estadual do Rio Preto e Zona de 
Amortecimento, Minas Gerais, Brasil. 
Fonte: Os autores.  
 
 

Tabela 4. Quantificação da ocorrência de confronto de uso da terra nas categorias de APP e AUR no Parque 
Estadual do Rio Preto e Zona de Amortecimento, no Estado de Minas Gerais. 
 

Classes uso 
da terra 

Categoria de APP* 
Área (ha) 

APP Total AUR 

1 2 3 4 5 ha % ha % 

Solo exposto 21,31 158,34 0,08 0,10 0,00 179,83 3,78 13,80 0,54 

Agropecuária 17,24 91,94 4,29 1,40 0,00 114,87 2,41 21,51 0,84 

Afl. Rochoso 282,92 1.784,36 30,23 30,15 1,82 2.129,48 44,75 1.645,56 64,25 

Formação 
Florestal 

150,38 1.075,74 32,44 5,98 0,00 1.264,54 26,58 571,14 22,30 

Formação 
Campestre 

142,38 837,65 60,52 0,91 0,03 1.041,49 21,89 257,28 10,05 

Água 1,65 22,29 0,09 4,08 0,00 28,11 0,59 51,70 2,02 

Total (∑) 615,89 3.970,32 127,64 42,62 1,85 4.758,32 100 2.560,99 100 

* APP1 - nascentes; APP2 - cursos d’água; APP3 - bordas de tabuleiros ou chapadas; APP4 - áreas com 
declividade superior a 45º; APP5 - áreas com altitude superior a 1800 m.  
Fonte: Os autores. 
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Comparando esses resultados aos de classes de uso da terra, nota-se que as áreas 

utilizadas para a agropecuária se concentram na ZA, comprovando o conflito de uso da 

terra em 2,41% das APP totais, o que representa a ocupação indevida de 114,87 ha. E 

dentre as categorias de APP observa-se que as de nascentes e cursos d’água são as mais 

afetadas por esta atividade, representando 15 e 80% desta ocupação indevida, 

respectivamente. 

Uma questão levantada por Morais et al. (2013) em estudo sobre a realidade de 

conflitos em comunidades do entorno do PERP, refere-se a falta de planejamento e práticas 

políticas efetivas que realmente possam englobar as populações rurais, sobretudo as 

residentes nas ZA de UC. O que alerta sobre a necessidade de efetivar modelos de gestão 

mais participativo, de forma a integrar interesses conservacionistas àqueles das 

comunidades locais sendo uma tentativa de erradicar ou mesmo minimizar conflitos diretos. 

Também, notamos a ação antrópica em APP de tabuleiros ou chapadas e áreas com 

declividade superior a 45º, onde 4,29 e 1,40 ha são ocupados pela agricultura ou pecuária. 

Como já discutido, as classes de solos das áreas dentro e no entorno do PERP apresentam 

um alto grau de erosividade, o que intensifica a necessidade de aplicação de práticas 

adequadas nestes locais visando a sua recuperação e conservação. 

Com relação à ocorrência do sistema natural o predomínio de afloramento rochoso 

em APP de cursos d’água (1.784,36 ha), áreas com declividade superior a 45º (30,15 ha) e 

áreas com altitude superior a 1800 m (1,82 ha), se deve ao tipo de formação geológica da 

região. 

A segunda maior classe de uso e ocupação do solo nas categorias de APP, com 

exceção de áreas com altitude superior a 1800 m, foi a de Formação Florestal, seguida da 

área de Formação Campestre. Sendo que esta última predominou em APP de bordas de 

tabuleiros ou chapadas ocupando uma área de 60,52 ha. 

Apesar da classe formação florestal apresentar a segunda maior em área de uso e 

ocupação, 150,38 ha (APP nascentes), 1.075,74 ha (APP cursos d’água) e 5,98 ha (APP 

áreas com declividade superior a 45º) observa-se a necessidade de monitoramento das 

mesmas afim de disponibilizar dados que possam subsidiar o planejamento e aplicação de 

ações junto à comunidade, que potencializem o retorno das funções ecossistêmicas dessas 

APP, conforme mencionado por Sutton et al. (2016). 

Com relação às AUR, nas quais o uso é admitido mediante manejo florestal 

sustentável aprovado por órgão competente, observamos situações semelhantes às APP, 

onde o uso e ocupação destas em nível de ocorrência seguiram a ordem de afloramento 
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rochoso (1.645,56 ha), formação florestal (571,14 ha) e formação campestre (257,28 ha), 

com antropização em aproximadamente 35,31ha, correspondendo a 1,38% de sua área 

total. Segundo o Código Florestal (BRASIL, 2012), se nestas áreas a supressão da 

vegetação ocorreu antes de 22 de julho de 2008, estas são consideradas consolidadas, e 

novas supressões de vegetação nativa para uso alternativo do solo são condicionadas à 

autorização do órgão estadual do meio ambiente.  

O uso das AUR é condicionado também ao seu registro no Cadastro Ambiental Rural 

(CAR), e podem ser contabilizadas nos programas de apoio e incentivo à preservação e 

recuperação ambiental, tal como o PRA (Programa de Regularização Ambiental). A 

ocorrência de áreas de conflito, em especial, nas APP de nascentes e cursos d’água indica 

a necessidade de um diagnóstico ambiental, e monitoramento destas áreas, com 

participação ativa da comunidade, a fim de definir técnicas e ações que viabilizem a 

recuperação e a conservação. Segundo Rodrigues; Gandolfi (2001), um programa de 

recuperação pode ser planejado segundo diferentes conceitos e com etapas distintas, mas 

sempre há uma fase de avaliação das condições atuais da área degradada. Esta é uma 

das principais fases dentro de um programa, pois somente a partir de um aprofundado 

conhecimento dos fatores de degradação e das características da área degradada 

propriamente dita é que se poderá identificar as dificuldades e se definir as estratégias que 

deverão ser empregadas para a restauração da vegetação ciliar. 

Diante dos resultados, a atualização do Plano de Manejo do PERP é uma alternativa 

para melhor eficiência de gestão. Segundo Morais et al. (2013), esse só foi aprovado dez 

anos após a sua criação em 2004. Em 2019 houve a atualização do plano de manejo 

(ZELLER et al., 2020) seguindo a prerrogativa a viabilidade de políticas de desenvolvimento 

sustentável. deve ser baseada na integração dos aspectos políticos, tecnológicos, naturais 

e socioculturais sob qualquer decisão ou ação visando, assim, unir áreas de conservação 

com todas as outras áreas relacionadas ao desenvolvimento econômico (DÍAZ et al. 2011; 

GÓMEZ-BAGGETHUN; RUIZ-PÉREZ, 2011). 

Isso também é válido para as políticas ambientais que se baseiam na restrição de 

uso da terra e direitos de propriedade, desconsiderando tradições e comportamentos que 

resultam em resistência e indignação. Pois, a percepção é de que políticas de conservação 

e ambientais são criadas e aplicadas com base nos princípios de repressão ou de restrição, 

visando restringir atividades humanas independente das possíveis contribuições que estas 

possam resultar para a biodiversidade ou para a qualidade de vida (FERNANDES; 
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GUIOMAR, 2016; SUROVÁ et al., 2018), resultando em conflitos de aceitação e oposição 

ativa às medidas e decisões. 

Assim, deve-se desenvolver ações junto à comunidade a fim de educar esses atores, 

a importância da conservação no PERP e sua ZA, incorporando as tradições das 

comunidades, e promovendo o desenvolvimento sustentável da região. Estas ações devem 

englobar atividades econômicas que resultem em renda para as famílias, mas sem a 

ocorrência de conflitos em áreas protegidas por lei. Uma alternativa indicada, seria a 

remuneração aos proprietários que conservem e protejam as APP de nascentes, de cursos 

d’água, AUR, e áreas limítrofes a estas, através de programas de pagamento por serviços 

ambientais (PSA), uma vez que esses locais são provedores desses serviços, como a 

conservação da biodiversidade, a conservação das águas e dos serviços hídricos, a 

regulação do clima, a conservação e o melhoramento do solo (BRASIL, 2012). Mas para 

isso, Jäppinen; Heliölä (2015) indicaram como etapa anterior estudos de valorização desses 

serviços, como ferramenta importante para o planejamento holístico, a tomada de decisão 

e a gestão no uso da terra. 

Neste estudo, os resultados obtidos vão ao encontro com as premissas 

estabelecidas pelo Instituto Mineiro de Gestão das Águas (IGAM) no Zoneamento 

Ambiental Produtivo (ZAP) de Minas gerais (MINAS GERAIS, 2020), que tem como objetivo 

aprimorar a gestão socioambiental e econômica de bacias hidrográficas (GORGENS et al., 

2021). A adoção de um zoneamento territorial visa orientar planejamento do uso 

conservacionista dos recursos naturais, permite simplificar e tornar ágil a gestão e o 

monitoramento do uso do solo adequado no âmbito da propriedade rural e, 

simultaneamente, do próprio conjunto dessas propriedades nas bacias hidrográficas. 

 

5. CONSIDERAÇÕES FINAIS 

 

A aplicação da metodologia utilizando-se de ferramentas disponíveis pelo SIG 

mostra-se eficiente na delimitação e quantificação das áreas de uso e ocupação da terra, 

das categorias de APP e na análise do conflito de uso no PERP e ZA. Confirmando a 

potencialidade do SIG como subsídio nas políticas públicas e gestão eficiente do uso da 

terra.  

No PERP e ZA, as classes de uso da terra afloramento rochoso e formação 

campestre predominaram, sendo estas consideradas de uso devido. As classes de uso 
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agropecuária e solo exposto (uso indevido), apresentaram em menores proporções, 

indicando considerável estado de conservação desta UC.  

Dentre as categorias de APP observa-se maior ocorrência das APP nascentes e 

cursos d’água, confirmando a importância do PERP e ZA como produtor de água para a 

região. Também de extrema importância no ciclo hidrológico da região, as APP declividade 

> 45° e altitude superior a 1800 m apresentaram menor ocorrência. 

Os usos da terra em APP nascente e cursos d’água e AUR são mais expressivos 

nas classes de afloramento rochoso, formação florestal e formação campestre. As classes 

de agropecuária e solo exposto apresentaram baixa incidência no conflito de uso em todas 

as APP e AUR analisadas. Porém, ao analisar sua ocorrência entre as categorias de APP 

verifica-se maior ocorrência de uso indevido nas APP nascentes e cursos d’água. 

Assim, se faz necessária a maior participação das comunidades nos processos de 

gestão do PERP e ZA. Esses atores poderão sinalizar suas reais necessidades e anseios 

socioculturais perante a UC. Tal ação auxiliará na identificação das principais causas de 

degradação em áreas protegidas e no desenvolvimento de políticas públicas 

socioambientais coerentes e eficientes na gestão do uso da terra.  
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